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						Post
					
								by cade perkins » Fri May 29, 2015 5:35 pm
			

			
			
			
			I use the Navigate buttons (and keyboard shortcuts) continuously.  As it is implemented now, those buttons navigate between documents.  Even if I close a document, using Navigate Backward will re-open it.  For me this behavior is extremely annoying and unhelpful.  I can already switch back and forth between documents using Ctrl-Tab or clicking tabs.  99% of the time, I am reading and/or searching documents independently--at least I want to navigate within the documents independently.   The behavior is also counter intuitive compared to modern internet browsers which remember history and navigate within tabs independently.



I have already searched for the options to change it and haven't found it, but I will ask anyway:  Is there currently a way to force the navigation buttons to work independently for each document?



If not, I suggest that this option be added.



To suggest details, have the buttons on the top toolbar act as they currently do, for those users who like and expect the current behavior.  But the same buttons appear in the Navigation Toolbar at the bottom of each document (next to the page number count and buttons).  Why not update the button design (blue arrow instead of green or something) and make those buttons unique to the document and add a new set of keyboard shortcuts for navigating?  Or allow the current keyboard shortcuts (Alt-Left, Alt-Right) to control the document-independent navigation instead of the multi-document navigation?  Let the user decide what is most useful by adding options.
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			Hi Cade,



Thanks for the post - I'll address each point in turn:


I use the Navigate buttons (and keyboard shortcuts) continuously. As it is implemented now, those buttons navigate between documents. Even if I close a document, using Navigate Backward will re-open it...

These buttons are contextual and what they do will change depending on whether the last action relevant to them, was to scroll through one particular document/change pages in that doc., or to change documents. 



i.e. If you change from doc. A to doc. B, they will change between the documents. 



If you change from Page 1 in doc. A, to page 5 in doc. A, they will change between those two pages.


I have already searched for the options to change it and haven't found it, but I will ask anyway: Is there currently a way to force the navigation buttons to work independently for each document?

No such feature currently exists, but I will see if an option can be added to make this only apply to pages, rather than documents.



We have had previous suggestions that detail something similar - one feature for Next/Previous View [Doc.] and one for Next/Previous View [Pages]. The previous stand point was that this isn't as simple of a feature as it sounds, and requires the storage of more data than is currently considered practical. As I understand it, it wasn't a definite no and could potentially be re-evaluated, should more users show an interest in this feature.



Cheers,


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Best regards



Will Travaglini

Tracker Support (Europe)

Tracker Software Products Ltd.

http://www.tracker-software.com
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			+1² for this feature request.



It is very annoying when closed documents are re-opened when you only wanted to jump back in your current document.



+1 to please just make "back/forward" work ONLY in the present tab/document.



For switching between tabs/documents, this is much better: FLST



Regards

David.P
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			Thanks for the input David [image: :)] 



I've made a note of the post and will keep an eye on the number of voices pitching in.


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Best regards



Will Travaglini

Tracker Support (Europe)

Tracker Software Products Ltd.

http://www.tracker-software.com
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			+1

i hope it is ok to bring back up such an old topic. Just wanted to voice, that i too would like such a feature. The buttons should work like forward and back buttons of browsers, i.e. being tab or windows specific. Two PDF are two different workflows, having the buttons mix up both is weird.
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			Thanks for your input Fred, I'll pass it along [image: :)]


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Best regards



Will Travaglini

Tracker Support (Europe)

Tracker Software Products Ltd.

http://www.tracker-software.com
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			+1 



...and back/forward even should be window/pane specific, in the sense that if you split one PDF's window in two seperate panes (for working with the same PDF at two different positions simultaneously), back/forward should remember the positions in the two panes separately.



Strangely, while this already works most of the time, sometimes the back/forward positions of two separate/split window panes of the same PDF get mixed up, which can be disturbing.



Regards,

David.P
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			Hi David,



Those back/forward buttons simply remember the position of a document that you were, in when you changed tabs. The splits are not treated separately, so the history should not be remembered separately.



As explained in your other post, remembering the history in this manner is quite difficult and would require us to track history in the same way that an internet browser does. While I believe that it may be technically possible, whether or not it is technically feasible is another matter.



I'll re-open the subject with the Dev. Team, but I still cannot make any guarantees.


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Best regards



Will Travaglini

Tracker Support (Europe)

Tracker Software Products Ltd.

http://www.tracker-software.com
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			Hello Will,



thank you for your reply.


Will - Tracker Supp wrote:Those back/forward buttons simply remember the position of a document that you were, in when you changed tabs. The splits are not treated separately, so the history should not be remembered separately.


From what I have been experiencing when using split windows (I do that all the time), the history actually is remembered separately for both splits of a window/document.



However, this does not work consistently all the time, meaning that sometimes the Editor erroneously jumps back and forth in the history of the left split, while you actually are in the right split (and vice versa).



Additionally sometimes, even when only using one split/window, the Editor confuses the the back/forward history, such that instead of one it takes two hits of the back button (or Alt+Left key presses) until you actually are taken back to the previous reading position.



It would be great if this could be fixed.



Best regards

David
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			Hi David,



Thanks for the further notes. As Will said - we've brought this back "on the table" for further thoughts and consideration, but at this moment we have not yet decided if the back/forward memory should be changed from it's current state.

The "double back" - might just be that you e.g. clicked with the mouse and moved the document 1 pixel, or e.g. clicked two bookmarks that take you to the same page - so those were two separate "events", but the visual result from them is the same, so you need to go back through them both before you notice the document view changes as well to the position before those last two.

The other issue with the split not working consistently will be checked as well.



Regards,

Stefan
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			Thank you Stefan,



good to hear that this is being worked on.



Regards

David
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			Thanks Stefan,



just to confirm this issue more clearly, here's the steps to reproduce:



1. Open a PDF file in PDF-XChange Editor and move around in the PDF in order to create view history

2. search for a word that is on a subsequent page using the search box

3. the page display jumps to the first search word occurrence 

4. now hit the back button (or press Alt+Left)

5. repeat steps "2" through "4" a couple of times.



What happens is that about every third time, in step 4 you are not taken to the previously viewed page, but to some other point in the view history.



Hopefully this can be reproduced by the developers, and subsequently fixed.



Regards

David
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			Hi David, 



I tried to, but can't seem to be able to reproduce the problem. Unless maybe in a situation when you get the notice that the end of the file has been reached, and then you need to click a second time on the search field itself to get to the first occurence of the seatch term in the file - but this has been two clicks in the first place so going back is expected to be two clicks. 

Do you think you can produce a video illustrating this more clearly?



Cheers,

Stefan
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			Hi Stefan,



thank you for trying to reproduce the issue. Indeed, it seems almost impossible to reproduce in v.6 (which I however am not yet using because of the search speed issue).



So, maybe it already has been solved? I will report back whether the problem still turns up as soon as I start using v.6.



Cheers

David
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			Hi David,



OK - in that case I am putting this topic "on hold" until then. [image: ;)]

Please do post back here when you are using V6 and if the problem is reproducible then at your end.



Regards,

Stefan
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			OK, will do so.

Cheers

David

 [image: :)]
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			Hi forum and support team,



unfortunately, the Navigate Backward and Forward function still seems to have a hitch.



Here's the steps to reproduce:



1.) Open a the attached file in PDF-XChange Editor and move around in the PDF in order to create some view history

2.) click on the link on page 1 

3.) the link takes you to page 5

4.) now hit Alt+Left (which is synonymous to pressing the "Back" button)

5.) repeat steps "2" through "4" a couple of times.



Result: at least every second time you repeat steps "2" through "4", you are not taken to where you came from but somewhere else (or nothing happens). The same occurs if you click on a page thumbnail and then hit Alt+Left in order to go back.



Note that the "Back" button itself works as expected. Only the Alt+Left shortcut seems to be affected.



Thank you for looking into this.



Best regards 

David.P
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	(565.16 KiB) Downloaded 196 times
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			Hi David,



Thanks for the info. and sample - have just reproduced here using those. The ticket number is RT-3535



Cheers,


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Best regards



Will Travaglini

Tracker Support (Europe)

Tracker Software Products Ltd.

http://www.tracker-software.com
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			Thank you Will, much appreciated!

Cheers

David
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			David.P wrote:unfortunately, the Navigate Backward and Forward function still seems to have a hitch.



Here's the steps to reproduce:



1.) Open a the attached file in PDF-XChange Editor and move around in the PDF in order to create some view history

2.) click on the link on page 1 

3.) the link takes you to page 5

4.) now hit Alt+Left (which is synonymous to pressing the "Back" button)

5.) repeat steps "2" through "4" a couple of times.



Result: at least every second time you repeat steps "2" through "4", you are not taken to where you came from but somewhere else (or nothing happens). The same occurs if you click on a page thumbnail and then hit Alt+Left in order to go back.



Note that the "Back" button itself works as expected. Only the Alt+Left shortcut seems to be affected.


This is unfortunately not fixed yet in v.318 -- so jumping back (using the Alt+Left key combination) to where you came from when moving around in a PDF is still erroneous most of the time  [image: :(] 



Regards

David.P
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			Hi David,



you are correct, the ticket status show this also did not make 318.



Again - I think Will mentions that the primary focus of 318 was fixing how we handle XFA forms.  It was a gargantuan task and as such a number of these other issues needed to be postponed.



I expect the next build to address most of the outstanding issues.



Your patience is appreciated.
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Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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			Thank you Paul, for the update.

Cheers

David
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Thank you.



Best regards
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Tracker Support (Europe)

Tracker Software Products Ltd.

http://www.tracker-software.com
			
						


		


				
						
				
				Top
			
					

		
		

	


				
		

			
				


																[image: User avatar]														

								David.P
							

							User
	Posts: 1518
	Joined: Thu Feb 28, 2008 8:16 pm



		
						

						
						Re: Navigate Backward and Forward
		


														
							
								Quote
							
						


							
						
									
						Post
					
								by David.P » Thu Dec 22, 2016 8:43 am
			

			
			
			
			Hello all,



I was just going to report that the issue is still there in Build 319.


David.P wrote:unfortunately, the Navigate Backward and Forward function still seems to have a hitch.



Here's the steps to reproduce:



1.) Open a the attached file in PDF-XChange Editor and move around in the PDF in order to create some view history

2.) click on the link on page 1 

3.) the link takes you to page 5

4.) now hit Alt+Left (which is synonymous to pressing the "Back" button)

5.) repeat steps "2" through "4" a couple of times.



Result: at least every second time you repeat steps "2" through "4", you are not taken to where you came from but somewhere else (or nothing happens). The same occurs if you click on a page thumbnail and then hit Alt+Left in order to go back.



Note that the "Back" button itself works as expected. Only the Alt+Left shortcut seems to be affected.


In the meantime I have found that if this happens, PDF-XChange Editor jumps back not ONE step (to where you came from) --- instead PDF-XChange Editor goes back TWO steps in the view history when pressing Alt+Left. 



Hopefully that helps to track down and fix this issue.



Regards

David.P
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			Hi David,



I'm not seeing that.  For me it appears to be going back one page only each time I hit Alt+Left.



Are you seeing this on all documents or only this one?



Paul
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Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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			Hello Paul,



thank you for checking the issue. I see this with all files. However, I will counter-check on some other PC's whether the issue is device-independent, and then report back.



Regards

David
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			It is a little bit difficult to understand how the registration of page visits/clicks exactly works.



This was the test I did:

- open the 6 page sample PDF "Charger-B6-Pro-Manual"

- walk through the six pages via the right arrow key (cursor button)

- now keep pressing the ALT key and use the left arrow key

with this, I get a stop at page 5, 3 and 1

- close and re-open the PDF

- now walk again through the six pages via the right arrow key, but click on each page that you pass

- now while pressing the ALT key and using the left arrow key, I get stops at 5, 4, 3, 2, 1

What is making this difference for PDF-XChange Editor ?



I also have the impression that some visits/clicks get lost/forgotten while you pass a second time on that same place.

I do not immediately see the logic in this. For me, 'all' the steps should be remembered/retained as long as the document is open. Even though I would agree with a limitation in the number of steps that has to be remembered (per document or even per window).



Also note the existence of the option "Back/Forward commands navigate through all open documents" via Edit > Preferences > Documents. I have turned this option OFF.



I am a little bit curious how your developers are storing the different visits in the computers' memory.

- Is there a separate list per window, per document, ...

- Are they using a time stamp for every visit ...

Would it be possible to exploit these data in different ways ... Some people would prefer to stay in the same window, other to stay in the same document, and still others would like to walk through their visits on whatever page in whatever PDF.



Best regards.


			
			
									
																
						


		


				
						
				
				Top
			
					

		
		

	


				
		

			
				


																[image: User avatar]														

								Patrick-Tracker Supp
							

							Site Admin
	Posts: 1645
	Joined: Thu Mar 27, 2014 6:14 pm
	Location: Vancouver Island
	
				Contact:
				
					
						Contact Patrick-Tracker Supp
					
					
						


						
																																								
																	
										Website									
																	

																					

					

				

			



		
						

						
						Re: Navigate Backward and Forward
		


														
							
								Quote
							
						


							
						
									
						Post
					
								by Patrick-Tracker Supp » Fri Dec 23, 2016 7:30 pm
			

			
			
			
			Hi Guys, 



I reproduced some errors with the navigation backwards as well using the file David P. supplied. Suddenly after many successful attempts, the Alt+ left action went to page 6 instead of page 1. I had not visited page 6 for 13 steps!



I will report this to the dev team. I suspect it will help them narrow down this issue. 



Thank you all for your help. 



Cheers!


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Cheers,



Patrick Charest

Tracker Support North America
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			Thank you Patrick. I have checked and I do see the issue as well on another PC. Actually what happens, every time when Alt+Left does not take me back to the last view, a subsequent Alt+Right does take me there. Thus, it seems that in case the issue arises:David.P wrote:...PDF-XChange Editor jumps back not ONE step (to where you came from) --- instead PDF-XChange Editor goes back TWO steps in the view history when pressing Alt+Left.



Wait, I think I just found that this is some kind of a timeout issue. Actually the key combo Alt+Left works perfectly -- but only if you wait like one second before using it.



This can also be seen when a document is opened freshly and you have jumped to another page (for example by clicking on a thumbnail or a bookmark or on a link) just ONCE (meaning you have only ONE entry in your view history). In this case, the "Back" button in the toolbar first stays greyed out, and only becomes operative after about a second.



Thus, in all cases where you have more than one entry in your view history, and where you then go to another page (for example by clicking on a thumbnail or a bookmark or a link), and then QUICKLY hit Alt+Left, your very last view history step is not operative yet and this is why PDF-XChange Editor takes you TWO steps back instead.



To conclude, this could be fixed if the view history timeout would NOT be triggered when moving around in the document by clicking on things (like on a thumbnail or a bookmark or a link), but if that view history timeout would be triggered ONLY when moving around in the document by scrolling (where a view history timeout makes sense because you don't want it to record every millimeter of your scrolling movements).



I other words, when moving around in the document by clicking on things (like thumbnails or bookmarks or links), there should not be any timeout. Instead, it should be possible to jump back immediately, for example by hitting Alt+Left.



The "one second view history recording timeout" really only should be operative when scrolling or panning!



I hope this helps to clear up and fix the issue.



Regards

David.P
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			Hello David, 



It looks like you've solved it! 



I fully agree that the timeout should only be effective when scrolling though pages. I have submitted a formal feature request to have the timeout behaviour changed. 



Cheers!


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Cheers,



Patrick Charest

Tracker Support North America
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			Hello Patrick,



I'm glad that what I wrote seems to make sense  [image: 8)]   



Thank you very much for submitting the formal feature request!



Looking forward to a removal of the 'view history recording timeout' from those cases where you "digitally" jump to places in a PDF by clicking on things -- as compared to the "analogous" moving around in a PDF by scrolling or panning (where the timeout is useful).



Cheers 

David
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Tracker Support North America
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			One little addendum to this feature request, that however makes a rather crucial difference:



Besides already being document-specific (and even split-view specific!) -- please also make the view history window-specific.



At the moment, if you open more than one document window of the same PDF document, using the "Window" -> "New Window" menu command, and then try to navigate backward/forward in one of those windows, the view history is shared between those two windows.

[image: Image]

Two windows of the same PDF document side-by side



This is extremely confusing because usually, you use multiple windows of one PDF document (like in above screenshot) for checking different pages of that document at the same time. In this case, if you try to jump backward/forward in, say, the right document window, suddenly and unpredictably the focus jumps to the left window and the left window view jumps to another page -- while you actually wanted to keep the left window as a reference and move your way around in the right window.



Please try for yourself -- this effect of the shared history between multiple document windows is very awkward and inconvenient, for the time being.



Thanks for considering this issue!

Regards

David

--

[Edit for clarity]
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			Hello David,



Have you tried to turn off the "Back/Forward commands navigate through all opened documents" checkbox under Edit -> Preferences -> Documents? Does that help?



Cheers,

Stefan
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			Hi Stefan and thanks for your input. 



Actually I had turned off that option. While this helps with the problem discussed earlier above, it does not alter the behavior just described (i.e. the focus unwantedly jumping between document windows, and the wrong document window reacting on back/forward commands).



Regards

David
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			Hi David,



I can certainly see your logic here. I've put in a formal feature request for consideration but, as always, cannot make any guarantees.



Cheers,


			
			
									
													If posting files to this forum, you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded.

Thank you.



Best regards



Will Travaglini

Tracker Support (Europe)

Tracker Software Products Ltd.

http://www.tracker-software.com
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			Thank you very much Will, for the fast action!

I'm very much looking forward for this to be fixed, if possible.

Best Regards

David
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			Hi all,



I wanted to inform everyone here of this topic:

viewtopic.php?f=62&t=31000#p124675

Enjoy!
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Our Web site domain and email address has changed as of 26/10/2023.
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			Hello forum and Daniel, Stefan, Paul, Patrick, Will:



I was going to ask about the status of these two feature requests, and/or give them a friendly *bump:



(A) View History Recording Timeout: David.P wrote: ↑Sat Dec 24, 2016 11:18 am
Looking forward to a removal of the view history recording timeout [the fixed one second delay when recording previous views] from those cases where you "digitally" jump to places in a PDF by clicking on things -- as compared to the "analogous" moving around in a PDF by scrolling or panning (where the timeout is useful).



Patrick-Tracker Supp wrote: ↑Fri Dec 23, 2016 10:17 pm
I fully agree that the timeout should only be effective when scrolling though pages. I have submitted a formal feature request to have the timeout behaviour changed.





(B) Window Specific View HistoryDavid.P wrote: ↑Tue May 30, 2017 10:29 am
Besides already being document-specific (and even split-view specific!) -- please also make the view history window-specific.




Will - Tracker Supp wrote: ↑Wed May 31, 2017 7:38 am
I can certainly see your logic here. I've put in a formal feature request for consideration






Thanks for any update on this!



Best regards

David
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			Hi, David.P



The tickets associated to both items you have mentioned here:

RT#3782: FR: Timeout behaviour

RT#3923: FR: Window specific history

Have unfortunately not seen any new action in a long time. I have requested that we look at these items again when time allows, for the moment however I do not have any news for you.



Kind regards,
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			Thank you Daniel, for giving these tickets a bump.



Hopefully we will see an update on the two issues soon.



Thanks @all, 

Best regards,

David
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			As another way to help moving forward and backward, it would be useful to be able to manually place a "mark" (e.g when I know I am going off on a tangent but want to come back to a spot) and then, with a hotkey be able to walk back through the marks.  I know I can leave a bookmark (Ctrl + Shift + B), but I find no hotkey for getting back, and I do not necessarily want to mess up my "permanent" bookmarks  with temporary ones (although it would be easy enough to delete).



Request:  
	A hotkey that "marks" the current view and puts it on a (short) stack. 

A second hotkey that pops the stack and moves me back a view.

Optionally a third key that enables me to go forward again.



Thanks.
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			Hello Daniel, Stefan, Paul, Patrick, Will:


David.P wrote: ↑Mon Mar 30, 2020 5:26 pm
(A) View History Recording Timeout: David.P wrote: ↑Sat Dec 24, 2016 11:18 am
Looking forward to a removal of the view history recording timeout [the fixed one second delay when recording previous views] from those cases where you "digitally" jump to places in a PDF by clicking on things -- as compared to the "analogous" moving around in a PDF by scrolling or panning (where the timeout is useful).



Patrick-Tracker Supp wrote: ↑Fri Dec 23, 2016 10:17 pm
I fully agree that the timeout should only be effective when scrolling though pages. I have submitted a formal feature request to have the timeout behavior changed.





Please @all, can this be looked into again? I believe that there is not even that much change to the code involved.



This issue makes me lose my way in my (often thousands of pages long) PDF documents up to hundreds of times a day. 



Imagine you are focused on a complex subject on page 213 in your PDF document, when you click on a PDF link on that page (or on a bookmark, thumbnail, etc.) to quickly glance at a reference text passage or a reference illustration on, say, page 1278 -- and then you want to jump back directly to where you came from, i.e. to page 213. 



However, when pressing "Alt+Left" or clicking the "Back" button on the toolbar, your PDF program instead takes you to a completely different page, and you then have to manually find page 213 again. 



This is extremely disruptive to concentration if happening over and over again day-in, day-out.



I'd be gladly prepared to cover any developer hours that this feature fix should require, if only the problem could be resolved -- for example by simply changing the view history recording timeout such that the timeout is only active when scrolling, but not when jumping to places in the document.



Thank you.
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			Hi, David.P



I am sorry that this has gone on so long. I have brought this to our dev team leaders directly (instead of simply bumping the ticket), and informed them that this has been going on too long. While I cannot make a promise, since the release just around the corner, I did ask them if there is any way we can possibly try to offer this in the initial V9 release.



No promises, but lets keep our fingers crossed and see what the wizards can do. If it is not available right away, I would expect to see it in the build following the initial V9 release.



Kind regards,
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			Thank you very much Daniel,



for bringing this to the attention of the developers once more.



Let's hope that it will be fixed soon -- in order to have an even better experience when quickly navigating a PDF in PDF-XChange Editor.



Best regards,

David

 [image: :)]


			
			
									
													David.P

PDF-XChange Pro
			
						


		


				
						
				
				Top
			
					

		
		

	


	

	
	
			
							Post Reply 
					
		
		
		
			
			
		
		
			


				
					
						Print view
					
				


		

	


			
		
	
		
		
	
	
		


		
			
							Display: All posts
1 day
7 days
2 weeks
1 month
3 months
6 months
1 year


								Sort by: Author
Post time
Subject


				Direction: Ascending
Descending


								

				
						

		

	



		

	
	
	
			
			71 posts
								1
	2
	Next


					

	





		
		
			Return to “PDF-XChange Editor”
		
	

	
		
			
				Jump to
				
			
		
			


				  Support
	 ↳   Welcome to Tracker Software Support Forums - Forum Rules & Regs
	  End User Forums - Current Releases
	 ↳   FAQ- Frequently Asked Questions (End Users)
	 ↳   PDF-XChange Editor
	 ↳   Editor plugins
	 ↳   OCR- For the PDF-XChange Editor and Viewer
	 ↳   PDF-Tools
	 ↳   Touchscreen Devices
	 ↳   PDF-XChange Print Drivers
	 ↳   PDF-XChange Viewer (End Users)
	 ↳   Office2PDF & MS Office Addin
	 ↳   How to forum
	 ↳   Network Administrator Support
	 ↳   Editor Videos
	  Software Developer Forums
	 ↳   PDF-X OCR SDK
	 ↳   PDF-XChange Editor SDK
	 ↳   PDF-XChange Core API SDK
	 ↳   PDF-Tools SDK (all our PDF DLL Libraries)
	 ↳   PDF-XChange Drivers API SDK
	 ↳   PDF-XChange Viewer SDK
	 ↳   PDF-XChange Translators
	  New Features Requests (End Users)
	 ↳   PDF-XChange (End Users FR)
	 ↳   PDF-Tools (End Users FR)


		

	


	










			




		All times are UTC
	
		Home				Board index
				







	

	

		
		
				
			Powered by phpBB® Forum Software © phpBB Limited
		

				        phpBB 3 Quarto theme by PixelGoose Studio

		
			
				Privacy
			
			|
			
				Terms
			
		

			


	
		 

	


	
		
			
		
		 


	

	
		
			
		
		

	




		Delete cookies
	Contact us








	
	



























			
			    
				
					
						
							Username: 

						


						
							Password: 

						





						
							
							



							
															 Remember me
													

					

				

								        
													Register
															        


			

			

